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Notices

This information was developed for products and services offered in the U.S.A. IBM may

not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently
available in your area. Any reference to an IBM product, program, or service is not intended to
state or imply that only that IBM product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any IBM intellectual property
right may be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents.
You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other country where
such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES
CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF

ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied
warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are
periodically made to the information herein; these changes will be incorporated in new editions
of the publication. IBM may make improvements and/or changes in the product(s) and/or the
program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only
and do not in any manner serve as an endorsement of those Web sites. The materials at
those Web sites are not part of the materials for this IBM product and use of those Web sites
is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling:
(i) the exchange of information between independently created programs and other programs
(including this one) and (ii) the mutual use of the information which has been exchanged,
should contact:

IBM Corporation
Department BCFB

20 Maguire Road
Lexington, MA 02421
US.A.



Such information may be available, subject to appropriate terms and conditions, including in
some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are
provided by IBM under terms of the IBM Customer Agreement, IBM International Program
License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly. Some
measurements may have been made on development-level systems and there is no guarantee
that these measurements will be the same on generally available systems. Furthermore, some
measurement may have been estimated through extrapolation. Actual results may vary. Users
of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products,
their published announcements or other publicly available sources. IBM has not tested those
products and cannot confirm the accuracy of performance, compatibility or any other claims
related to non-IBM products. Questions on the capabilities of non-IBM products should be
addressed to the suppliers of those products.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrates
programming techniques on various operating platforms. You may copy, modify, and distribute
these sample programs in any form without payment to IBM, for the purposes of developing,
using, marketing or distributing application programs conforming to the application
programming interface for the operating platform for which the sample programs are written.
These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot
guarantee or imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to IBM for the
purposes of developing, using, marketing, or distributing application programs conforming to
IBM’s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must include a
copyright notice as follows:

(c) (your company name) (year). Portions of this code are derived from IBM Corp. Sample
Programs. (c) Copyright IBM Corp. _enter the year or years_. All rights reserved.

Additional legal notices are described in the legal_information.html file that is included in
your Rational software installation.
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Business Machines Corporation in the United States, other countries, or both.
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the United States, other countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United
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Preface

About This Manual

This document describes Version 2003.06.00 of both Rational ClearCase configuration
management software and Rational ClearCase MultiSite software for the UNIX
operating system.
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ClearCase Documentation Roadmap

Software
Development

Developing Software

Build
Management

Building Software

OMAKE Guide
(Windows platforms)

xii Release Notes

Orientation

Introduction
Release Notes

Online tutorials

More Information
Command Reference
Online documentation

Help files

(See online documentation)

Project
Management

Managing Software Projects

Administration

Installation Guide

Administrator’s Guide
(Rational ClearCase/
Rational ClearCase LT)

Administrator’s Guide
(Rational ClearCase MultiSite)

Platforms Guide
(See online documentation)



Typographical Conventions

This manual uses the following typographical conventions:

ccase-home-dir represents the directory into which the ClearCase Product Family has
been installed. By default, this directory is /opt/rational/clearcase on UNIX and
C:\Program Files\Rational\ClearCase on Windows.

Bold is used for names the user can enter; for example, all command names, file
names, and branch names.

A sans-serif font is used for file names, directory names, and file extensions.

A bold sans-serif font is used for GUI elements; for example, menu names and
names of check boxes.

Italic is used for variables, document titles, glossary terms, and emphasis.

A monospaced font is used for examples. Where user input needs to be
distinguished from program output, bold is used for user input.

Nonprinting characters appear as follows: <EOF>, <NL>.

Key names and key combinations are capitalized and appear as follows: SHIFT,
CTRL+G.

[ IBrackets enclose optional items in format and syntax descriptions.

{ }Braces enclose a list from which you must choose an item in format and syntax
descriptions.

| A vertical bar separates items in a list of choices.

...In a syntax description, an ellipsis indicates you can repeat the preceding item or
line one or more times. Otherwise, it can indicate omitted information.

Note: In certain contexts, you can use “...” within a pathname as a wildcard,
similar to “*” or “?”. For more information, see the wildcards_ccase reference page.

I/?VI
If a command or option name has a short form, a “medial dot” ( - ) character
indicates the shortest legal abbreviation. For example:

Isc-heckout

This means that you can truncate the command name to Isc or any of its
intermediate spellings (Isch, 1sche, Ischec, and so on).
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Online Documentation

The ClearCase Product Family (CPF) includes online documentation, as follows:

Help system: Use the Help menu, the Help button, or the F1 key. To display the
contents of the online documentation set, do one of the following:

= On UNIX, type cleartool man contents
= On Windows, click Start > Programs > Rational Software > Rational ClearCase > Help

= On either platform, to display contents for Rational ClearCase MultiSite, type
multitool man contents.

= Use the Help button in a dialog box to display information about that dialog box or
press Fl1.

Reference pages: Use the cleartool man and multitool man commands. For more
information, see the man reference page.

Command syntax: Use the —help command option or the cleartool help command.

Tutorial: Provides a step-by-step tour of important features of the product. To start
the tutorial, do one of the following:

= On UNIX, type cleartool man tutorial

= On Windows, click Start > Programs > Rational Software > Rational ClearCase >
ClearCase Tutorial

PDF manuals: Navigate to:
®  On UNIX, ccase-home-dir/doc/books

®  On Windows, ccase-home-dir\doc\books
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ClearCase Integrations with Other Rational Products

Integration

Description

Where it is documented

Base ClearCase-
ClearQuest

Associates change requests with
versions of ClearCase elements.

ClearCase: Developing Software
ClearCase: Managing Software
Projects

ClearQuest: Administrator’s
Guide

Base ClearCase-
Apex

Allows Apex developers to store
files in ClearCase.

Installing Rational Apex (UNIX)

Base ClearCase-
ClearDDTS

Associates change requests with
versions of ClearCase elements.

ClearCase ClearDDTS Integration

Base ClearCase-

Allows developers to invoke

PurifyPlus Help

Rose

PurifyPlus ClearCase from PurifyPlus.

Base ClearCase- Archives RequisitePro projects | RequisitePro User’s Guide
RequisitePro in ClearCase. RequisitePro Help

Base ClearCase- Stores Rose models in ClearCase. | Rose Help

Base ClearCase-
Rose RealTime

Stores Rose RealTime models in
ClearCase.

Rose RealTime Toolset Guide
Rose RealTime Guide to Team
Development

Base ClearCase-
SoDA

Collects information from
ClearCase and presents it in
various report formats.

Using Rational SoDA for Word
Using Rational SoDA for Frame
SoDA Help

Base ClearCase-
XDE

Stores XDE models in ClearCase

XDE Help

UCM-ClearQuest

Links UCM activities to
ClearQuest records.

ClearCase: Developing Software
ClearCase: Managing Software
Projects

ClearQuest: Administrator’s
Guide

UCM-Purify Plus

Allows developers to invoke
ClearCase from PurifyPlus.

PurifyPlus Help
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Integration

Description

Where it is documented

UCM-RequisitePro

Allows RequisitePro
administrators to create baselines
of RequisitePro projects in UCM,
and to create RequisitePro
projects from baselines.

RequisitePro User’s Guide
RequisitePro Help
Using UCM with Rational Suite

UCM-Rose Stores Rose models in ClearCase. | Rose Help
Using UCM with Rational Suite
UCM-Rose Associates activities with Rose RealTime Toolset Guide
RealTime revisions. Rose RealTime Guide to Team
Development
UCM-SoDA Collects information from Using Rational SoDA for Word

ClearCase and presents it in
various report formats.

Using Rational SoDA for Frame
SoDA Help

UCM-TestManager

Stores test assets in ClearCase.

Rational TestManager User’s Guide
TestManager Help
Using UCM with Rational Suite

UCM-XDE

Stores XDE models in ClearCase

XDE Help

UCM-XDE Tester

Stores XDE Tester Datastores in
ClearCase

XDE Tester Help
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ClearQuest Integrations with Other Rational Products

Integration

Description

Where it is documented

ClearQuest-Base

Associates change requests with

ClearCase: Developing Software

and to associate requirements
with ClearQuest change
requests.

ClearCase versions of ClearCase elements. | ClearCase: Managing Software
Projects
ClearQuest: Administrator’s Guide
ClearQuest- Allows developers to invoke PurifyPlus Help
PurifyPlus ClearQuest from PurifyPlus. ClearQuest: Administrator’s Guide
ClearQuest- Allows developers to invoke Rational Suite: Administrator’s
RequisitePro ClearQuest from RequisitePro Guide

ClearQuest: Administrator’s Guide

ClearQuest-SoDA

Collects information from
ClearQuest and presents it in
various report formats.

Using Rational SoDA for Word
Using Rational SoDA for Frame
SoDA Help

ClearQuest-Test
Manager

Allows developers to invoke
ClearQuest from TestManager.

Using Rational TestManager
ClearQuest: Administrator’s Guide

ClearQuest-Robot

Allows developers to invoke
ClearQuest from Robot.

Rational Robot User’s Guide
Rational Robot Help

ClearQuest-UCM

Links UCM activities to
ClearQuest records.

ClearCase:
Developing Software
ClearCase: Managing Software
Projects
ClearQuest: Administrator’s Guide
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Customer Support

If you have any problems with the software or documentation, contact
Rational Customer Support by telephone or fax. You can find information
about support hours, languages spoken, or other support information at

www.ibm.com/software/rational/support/.

Your location Telephone Facsimile
Asia Pacific +61-2-9419-0111 +61-2-9419-0123
Australia Australia

Europe, Middle
East, and Africa

+31-(0)20-4546-200 Netherlands

+31-(0)20-4546-201 Netherlands

Latin America and | +1-408-863-4000
Mexico Cupertino, CA

Use either location: +1-408-863-
4194
Cupertino, CA

+1-781-676-2460
Lexington, MA

United States and 1-800-IBM-SERV
Canada

Use either location: 1-408-863-4194
Cupertino, CA

1-781-676-2460
Lexington, MA
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What’s New in
ClearCase

This chapter describes new features and other changes in Version 2003.06.00 of
Rational ClearCase, as follows:

m  New Features
®  Announcements
= Changes to the Commands

»  Changes to the Documentation

New Features

The following is a summary of the new features that are introduced in this release
of ClearCase:

= ClearCase Web

= Mainframe Connector Remote Builds

®  Build Enhancements

»  New and Enhanced Integrations

= UCM Enhancements

»  MVES Scaled for Multiprocessor Systems

ClearCase Web

ClearCase Web supports the following new features:

= The Rational Web Platform (RWP) is the new server for the Web interface.
ClearCase is a CGI executable that runs with the Apache Web server provided
by RWP. Rational no longer supports any other Web server as the server for
this interface. For more information, see the Administrator’s Guide for Rational
ClearCase.

= Support for Mozilla 1.4-based browsers on AIX, HP-UX/IPE SGI IRIX, and Linux
systems. Netscape 7 is supported on Solaris and HP-UX.



Reverse proxy support. The Web interface allows requests from external users to
be passed through a firewall to an internal ClearCase Web server.

Performance improvement. When you perform an update, load, or restore
operation on a large number of files, the associated Progress page displays either a
Show Details or Hide Details button. Hiding the details can improve performance
dramatically when several thousand or more file elements are the subjects of

the operation.

You can create a UCM view based on an existing development stream, even if you
are not the owner of the stream, as long as you are a member of the same group.

Support for multibyte character sets.
Support for Sun JVM 1.4.2.

Full-text search capabilities in Help through the Search tab in the left navigation
pane.

Using Compare (in ClearCase Properties), you can compare the current version of
an element with any other version. In previous releases, you could compare a
version only with its predecessor.

For complete information, see the Help.

Mainframe Connector Remote Builds

The Mainframe Connector Remote Build feature allows you to submit build requests
from ClearCase client platforms to OS/390 (MVS and USS) and z/OS (MVS and
USS). You can configure Remote Build to return the derived objects to the client
platforms, where you can version them. In addition, you can audit the builds using
clearmake. For more information, see the Mainframe Connectors User’s Guide for
Rational ClearCase, which is available from the Help and the section, Changes to
Mainframe Connector Remote Builds.

Build Enhancements

The following is a summary of build-related enhancements. For more information,
see Building Software.

For Java builds, the clearmake command offers a special makefile target: .JAVAC.
This feature enables clearmake to use heuristics to determine class dependencies
from audits of Java compiles in dynamic views. These dependencies are stored in
.class.dep files for future clearmake runs. They allow clearmake to build .class
targets in the same order as the Java compiler does, which, in turn, enables winkin
of derived objects.

There is a new environment variable:
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o CCASE_NO_DIRENT_CACHE forces clearmake to obtain the status of files
individually by pathname when attempting to apply a suffix rule. Thus, when
a view selects no version of an element, stat fails to match, and clearmake does
not apply a suffix rule for that file.

= The flags -A and -B have been added to the list of flags that can be passed through
MAKEFLAGS and picked up by submakes.

= The clearmake command supports the following long command line
options in GNU compatibility mode (see the makefile_gnu reference
page): — —-debug, — —directory, — —-dry-run, — —environment-override,
— —file, — —ignore-errors, — —include-dir, - —just-print, — — keep-going,
— -makefile, — —-no-builtin-rules, — —no-builtin-variables, — —no-print-directory,
— —print-data-base, — —print-directory, — —question, — —quiet, — -recon, — —silent,
— —warn-undefined-variables.

= The clearmake command includes a -v level debug message so that the output
from distributed builds includes the name of the .bldhost file that is being read.

= The catcr —recurse —-long command prints the extended path of the DO that caused
the config record to be written.

= The rmdo options —-before and —since remove DOs before and since a specified
date, respectively.
New and Enhanced Integrations

This section describes integrations that are new or enhanced in this release.

WebSphere Studio

This release introduces the integration of ClearCase with WebSphere Studio. The
integration supports WebSphere Studio versions 4 and 5.0 running on versions 1.0,
2.0, and 2.1 of the Eclipse shell. For more information, see the Help.

Forte for Java

This release introduces the integration of ClearCase with Forte for Java version 3.0.
For more information, see the Help.

JBuilder

This release provides support for Borland JBuilder versions 5, 6, and 7. For more
information, see the Help.

Chapter 1 - What's New in ClearCase 3



UCM-ClearQuest Integration

This release includes the following enhancements to the UCM-ClearQuest integration:

The integration is now supported on HP-UX 11.11 and AIX.

GUIs in the style of ClearCase on Windows. You can now create activities and
view an activity’s property sheet from within the Checkin, Checkout, and Add to
Source Control dialog boxes. For more information, see the Help.

Performance enhancement. This release incorporates changes that reduce the
communications overhead between ClearCase and ClearQuest.

During a deliver operation in a project enabled for ClearQuest that has set the
policy Transition to Complete After Delivery, if any of the activities being delivered
is set to a view, the integration unsets the activity from that view after it transitions
the activity to a Complete type state. For more information, see Managing Software
Projects.

Format options implemented for this integration enable you to determine

the view set to the UCM activity (%[viewlp), the ClearQuest record type
(%l[crm_record_typelp), the likeliest view for resolving the names of versions in a
change set (%[name_resolver_view]p), and the name of the ClearQuest database
(%lcrm_database]p). See the fmt_ccase reference page.

You can submit new ClearQuest records using the activity list dialogs. For more
information, see Developing Software.

New policies provide more flexibility in controlling the behavior of projects
enabled for ClearQuest. For more information, see Managing Software Projects
and the Help.

Base ClearCase-ClearQuest Integration

This integration supports the association of multiple file imports (by clearfsimport)
with a single change request. For more information, see the clearfsimport
reference page.

Enhanced capabilities for making ClearQuest associations. The integration lets
you specify a file’s association with a defect or defects by using checkout or
checkin comments that contain a text pattern specified in the environment variable
CQCC_COMMENT_PATTERN, or obtain a list of files to associate with a defect from
the environment variable CQCC_AUTO_ASSOCIATE.

UCM Enhancements

This release includes the following enhancements to UCM:
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Single-stream projects. Customers who prefer a serial, rather than a parallel,
development environment can use single-stream projects. A single-stream project
contains one stream: the integration stream. Developers join the project by creating
an integration view attached to the integration stream. Because developers

work directly on the integration stream, they do not perform deliver or rebase
operations. Single-stream projects are recommended only for small teams of
developers who work closely together.

Read-only streams. You can designate specific streams as read-only to prevent
developers from making changes to the stream’s components. For example, you
might create a read-only stream for your release engineering team members so
that they can access a set of baselines without inadvertently making changes to
components.

Support for multiple PVOBs that share components. Projects within two or more
PVOBs may reference some of the same components. To handle the common
global types, administrators must link the PVOBs to an administrative VOB or a
PVOB that acts as an administrative VOB. This feature supports the use case in
which two project teams working in different PVOBs combine their work and need
to share components.

Baseline naming templates. Project managers can specify a template to be used
in naming baselines within a project. They construct a baseline naming template
by choosing tokens that represent variables such as project name, component
name, date, and so on.

Performance enhancements. This release incorporates changes that reduce the
processing and communications overhead for almost all UCM operations.

Format options for object properties. Formatting options for UCM

object properties enable you to output the initial baseline of a component
(%linitial_bl]Xp), the activities of a baseline (%[activities]Xp), the promotion level
of a baseline (%[plevellp), the promotion levels defined in the PVOB (%[plevels]),
and whether or not a stream is read-only (%[read_onlylp). See the fmt_ccase
reference page.

Delivering the current activity. The —cactivity option for deliver specifies that the
currently set activity is to be delivered. See the deliver reference page.

Status button in UCM GUIs. The Deliver from Stream in Progress and Rebase in
Progress GUIs now include a Show Details button. This eliminates the need to
select Properties on the Stream and then click the Status button.

Determining baseline membership. The Isbl command supports the options
-member_of and -recurse, which enable you to determine whether a baseline is a
member of a composite baseline. See the reference pages for Isbl and fmt_ccase.
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= Displaying the activities of a delivery. In the Compare Baselines GUI, you
can right-click a deliver integration activity on the Activities tab to show the
contributing activities that were included in the deliver operation.

For integration activities in projects enabled for ClearQuest, you can click Actions
> Contributors on the ClearQuest record form to display the activities that were
included in the deliver operation.

= Using Isproject to display ClearQuest policies. The Isproject -1 command
displays ClearQuest policies for a project that is enabled for ClearQuest. For more
information, see the Isproject reference page.

= Checking PVOB/component relationships. The checkvob command incorporates
functionality for detecting and repairing relationships among a PVOB, a project’s
components, and for projects that are enabled for ClearQuest, the ClearQuest user
database. For more information, see the Administrator’s Guide and the checkvob
reference page.

= Listing activities by user. You can use the Isactivity command to list only those
activities that are owned by a specified user. See the Isactivity reference page.

= Checking in all versions in an activity’s change set. Using the xclearcase File
Browser, you can click Projects > Checkin All in Current Activity to check in all
versions in the activity’s change set.

= New Events. There are new events that support UCM operations. See the
events_ccase reference page.

For more information, see Managing Software Projects, the reference pages cited in
this section, and the Help.

MVFS Scaled for Multiprocessor Systems

The ClearCase multiversion file system (MVFS) has been enhanced to reduce lock
contention and to scale to large systems (that is, 8—way multiprocessors or greater)
that are accessed by multiple users. This enhancement results in noticeably better

performance.

Mozilla Environment Variables
New environment variables control the Mozilla browser, as follows:
=  CCASE_MOZILLA may be set to specify Mozilla as the default browser.
=  CCASE_MOZILLA_OPT may be set to pass options to the Mozilla command line.

= CCASE_MOZILLA_NEW_WINDOW may be set to “,new-window” to open a new
window or to “,new-tab” to open a new tab in an existing window.
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These environment variables are comparable to the CCASE_NETSCAPE and
CCASE_NETSCAPE_OPT environment variables that are described in the reference
page for xcleardiff. The script display_url.sh treats them as follows:

If CCASE_MOZILLA is set, the browser that it specifies is used.
Else if CCASE_NETSCAPE is defined, the browser that it specifies is used.

If neither CCASE_MOZILLA nor CCASE_NETSCAPE are defined, an attempt is made
to find the Mozilla executable in the search path first. Then, if it cannot be found,
Netscape is used.

Miscellaneous Enhancements

This section describes miscellaneous enhancements in this release.

Uncataloging elements that have checkouts. By default, the rmname operation
behaves correctly by failing when the element specified to be uncataloged is
checked out. See the rmname reference page.

Creating elements in view-private directories. The mkelem command supports a
—-mkpath option that creates an element from a view-private file or directory that
resides in a view-private directory. The distinctive behavior of this option is that it
also creates elements from all view-private directories in the element path. See
the mkelem reference page.

Handling white space during merges. In previous releases, you could ignore
white space when using cleardiff and xcleardiff by means of the —-blank_ignore
command-line option or the Ignore white space during merge option in the Diff
Merge Properties window. However, in graphical mode the option was supported
only for comparisons, not merges. At this release, the Ignore white space option

is available during a merge. In addition, the command option —favor_contrib
enables you to specify a contributor to be used for white space formatting of
unchanged lines. For graphical merges, the cleardiff and xcleardiff GUIs display a
list of contributors (Take white space changes from:) from which you can select one
to be used for white-space formatting. See the Help and the reference pages for
cleardiff and xcleardiff.

MVES performance tuning. The getcache and setcache options -mvfs —persist
enable you to specify MVFS cache settings that persist across restarts of the MVFS.
For more information, see the reference pages for getcache and setcache. In
addition, MVFS performance has been enhanced so that it scales better on systems
with large memories, including those hosting dynamic views.

You no longer have to rebuild the HP-UX kernel to make MVFS caching settings
persistent. On Solaris, MVFS performance parameters are now handled by this
interface; the install program copies parameters from /etc/system to setcache-style
values.
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Multiple mount points for paths to remote storage. The environment variable
CCASE_GPATH_HINTS enables you to specify a set of NFS mount points that
mkview, mkvob and mkstgloc try when attempting to construct pathnames to
remote storage. See the env_ccase reference page.

Checkins from merge dialog box. The dialog box for merge operations includes
an option for checking in merged element versions. For details, see the Help.

Redisplaying merge session transcripts. The Display Transcript command
redisplays a merge session transcript after the merge session is completed and the
transcript dismissed. This command is available from the View menu.

Ignoring signal handlers. User settings to ignore signal handlers for SIGINT,
SIGHUP, and SIGTERM are honored by cleartool and multitool. Previously,
they had been replaced by program internal handlers. User signal handlers that
are not SIG_IGN will still be replaced.

Refreshing selected elements during a merge. Refreshing a large number of
elements during a merge can be a time-consuming operation. Now you can

also specify that only certain elements are to be refreshed. The Refresh Selected
Elements menu option is available from the Merge menu and in the pop-up menu
for an individual item in the merge manager log.

Enhanced support for mounting multiple VOBs. On Solaris, ClearCase supports
mounting up to 5119 VOBs with up to 512 unique view-extended pathnames per
VOB. In addition, up to 2560 VOBs exported for non-ClearCase access may be
mounted. On HP-UX, you can mount up to 8191 VOBs with up to 1024 unique
view-extended pathnames. On Linux, the default limit is 1022 VOBs.

Object name restriction relaxed. The restriction on object names that disallowed
numerics values has been relaxed such that only integers are disallowed. The data
converters (the commands that are prefixed clearexport_) have been modified to
take advantage of this change. For information about object naming rules, see

the cleartool reference page.

Announcements

This section contains announcements, as follows:

Status of the Feature Level
End of Support for ClearCase Attache Software
Distribution of Perl Extension

Perl Software Distributions in This Release
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»  UCM-ClearQuest Integration Support for UCM Packages

m  Miscellaneous Announcements

Status of the Feature Level

This release introduces feature level 4. Table 1 shows all supported feature levels and
the versions at which they were introduced.

Table 1 Feature Levels and ClearCase Versions

Feature level Introduced in version
2 4.0

3 2002.05.00

4 2003.06.00

Feature level 3 placed constraints on client/server compatibility in UCM
environments. Feature level 4 introduces no additional constraint; it is equivalent to
feature level 3 in terms of PVOB client/server compatibility. For information about
feature level 3, see the Version 2002.05.00 Release Notes for your product. Also note
that read-only streams and single-stream projects are restricted to PVOBs at feature
levels 3 and higher (see the reference page for mkstream).

Raising the feature level to 4 (or in the case of a replicated VOB, raising the VOB
family to feature level 4), results in the following changes in the VOB:

= The predefined element types xml, html, and rose (if they exist) are renamed to
xml_v5.0, html_v5.0, and rose_v5.0, respectively. Similarly, element type names
that you have changed are renamed to name_v5.0. The v5.0 types lose their status
as well-known element types. Accordingly, when you create new elements, the
file-to-type mapping mechanism no longer treats these types as the defaults (see
the cc.magic reference page). The type of an existing element does not change;
however, you can use chtype to change it.

=  The new predefined element types xml, html, and rose are created. The purpose
of replacing these types is to base the type managers on the binary_delta type
manager instead of the text_file_delta manager. The cc.magic file maps new
elements to these types by default.

For instructions about raising the feature level of an unreplicated VOB, see the
chflevel reference page.

For instructions about raising the feature level of replicated VOBs, see the
Administrator’s Guide for Rational ClearCase MultiSite. Note that in a VOB family, the
replica that masters the VOB object must master the element types xml, html, and rose.
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End of Support for ClearCase Attache Software

At this release, Rational ClearCase Attache is no longer a supported product.

Distribution of Perl Extension

ClearCase::CtCmd is a Perl extension that takes cleartool-like arguments.
ClearCase::CtCmd takes a string or an array as an input argument and returns a
three-element Perl array, as follows: a status bit, a scalar string corresponding to
stdout, and any error message corresponding to stderr. This Perl extension and its
documentation are available from www.cpan.org.

Note: After upgrading to Version 2003.06.00, you must rebuild ClearCase::CtCmd
to account for the addition of new libraries and symbols to ClearCase

Perl Software Distributions in This Release

Perl 5.6.1 is distributed with ClearCase. Perl 4 is not included in this release. For
backward compatibility, this release also includes a modified version of Perl 5.002. To
use 5.002 instead of Perl 5.6.1, set CCASE_USEPERL5 to a nonempty string (see the
env_ccase reference page). To verify the version that is being invoked, type ccperl
-ver.

In conformance with the Artistic License Agreement under the terms of which Perl is
distributed, Table 2 describes the modifications that were made to Perl 5.6.1.

Table 2 Modifications to 5.6.1 Perl Distribution

Reason for modification

Modification Source file modified

Accommodation of underlying C library changes or other OS changes

Add libmalloc, libndir to link list hints/hpux.sh

Use Rational naming conventions

Configure. Add prompt for executable name Configure
Allow arbitrary link library path Makefile.SH
Allow arbitrary executable and library name Makefile.SH, installper!

Defect fixes independent of public domain

Do not free environment in perl_destruct when perl.c
—DPERL_USE_SAFE_PUTENV

Do not free environment in Perl_my_setenv when | util.c
—DPERL_USE_SAFE_PUTENYV
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Table 2 Modifications to 5.6.1 Perl Distribution (Continued)

Reason for modification

Modification Source file modified

Compiler related changes

Allow C++ compiler on Sun5 Configure

Likewise, in conformance with the Artistic License Agreement Table 3 describes the
modifications that were made to Perl 5.002.

Table 3 Modifications to 5.002 Perl Distribution

Reason for modification

Modification Source file modified

Accommodation of underlying C library changes or other OS changes

Fix AIX 4.2 relocation defect dl_aix.xs
Perl dynaloader not initializing C++ shared di_hpux10.xs
libraries

New functions and other changes needed by the embedded ClearGuide interpreter

Fix hang when invoked from ClearGuide di_dlopen_C++_sun4.xs

Changes related to ClearGuide modules

Put __END__ at end so Autosplitter succeeds Dynaloader.pm

Inclusion of changes/upgrades from public domain to sources

5.005_62 BPD rule dumps core dl_aix.xs, cop.h, pp_ctl.c,
pp_hot.c

5.004_04 Allow sigaction() in sig handlers util.c

Defect fixes independent of public domain

Fix to allow debugging pp_ctl.c

Fix to build of miniperl] to fix Linux core dump perl.c

Fix sprintf for Aix 4.2/3 doop.c, pp_sys.c

AIX dynaloader; always call load AndInit dl_aix.xs

Removed misleading error message di_dlopen_C++_sun4.xs

Compiler related changes

Fixes to allow certain new compilers to function proto.h, perl.h
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Table 3 Modifications to 5.002 Perl Distribution (Continued)

Reason for modification

Modification Source file modified
Use cxxshl_ routines to handle C++ static di_hpux.xs, dl_hpux10.xs
initializers

Support aCC dl_hpux10.xs

Remove comment characters from within unixish.h

comments to quiet AIX compiler warnings

Non-shipping changes to accommodate clearmake in build environment

Remove perly.y from build directories; change make_ext, perly.y
build scripts to eliminate -V switch

Change in build or test environment to Perl modules as shipped

Test harness fix ParseWords.pm

Fix autoloading ParseWords.pm

Version related changes

Remove v5.004 test HTML.pm, Entities.pm

Remove use strict for use by Perl 5.002 HTML.pm, Parser.pm

This release is the last major release that includes 5.002. The unmodified sources
for Perl versions 5.002 and 5.61, as well as the binaries built from them, may be
downloaded from http://www-3.ibm.com/software/awdtools/clearcase/support/index.html.

UCM-ClearQuest Integration Support for UCM Packages

In the Project Properties and New Project Wizard GUIs, the ClearQuest page displays
the policies that are appropriate for the UCM level of the ClearQuest user database
associated with the project. If the ClearQuest user database uses the revision 5.0
UCM package (corresponding to Version 2003.06.00), the available policies are as
documented in the Help and in Managing Software Projects.

If the ClearQuest user database uses an earlier UCM package, the available policies
are as follows:

=  For UCM package revision 2.0:
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o Check assignment before WorkOn
o Check before ClearCase delivery
o Do ClearQuest action after delivery
= For UCM package revisions 3.0 and 4.0:
o Check assignment before WorkOn
o Check before ClearCase delivery
o Check ClearQuest mastership before delivery

o Do ClearQuest action after delivery

Miscellaneous Announcements

This section contains miscellaneous announcements about this release.

Change in Installation and Administration Directories

The default installation directory has been changed from /usr/atria to
/opt/rational/clearcase. The administration directory has been changed from
/var/adm/atria to /var/adm/rational/clearcase.

Manipulation of Directories When Upgrading from Version
2002.05.00 to 2003.06.00

During an upgrade from Version 2002.05.00 to 2003.06.00, the installation tool
moves /var/adm/atria to /var/adm/atria.preserve. Critical files are moved back

to /var/adm/rational/clearcase when the installation is complete. Other files or
customizations stored in this directory remain in /var/adm/atria.preserve after the
installation is complete.

CLEARCASE_OBSO_SYN Not Supported
The environment variable, CLEARCASE_OBSO_SYN, is not supported in this release.

Removal of the Term “atria”
The following changes were made to remove the term atria:

= The default installation directory has been changed from /usr/atria to
/opt/rational/clearcase.

» The administration directory has been changed from /var/adm/atria to
/var/adm/rational/clearcase.

Chapter 1 - What's New in ClearCase 13



m  The environment variable ATRIAHOME has been renamed CLEARCASEHOME.

= The startup/shutdown scripts rc.atria and atria have been renamed rc.clearcase
and clearcase, respectively. Symbolic links from the old names have been
established for this release.

Examples Removed

Except for ClearCase API examples, the examples in ccase-home-dir/examples have been
removed.

Available Versions of ClearCase—ClearQuest Integrations

The ClearQuest Configuration tool (cqconfig) offers the administrator a choice of
the V1 (previous) integration or the V2 (new) integration implementation, allowing
administrators to migrate to the new integration as appropriate. The default values
were set to V2 on UNIX (because V2 was a superset of the V1 implementation) and
to V1 on Windows (because the V1 integration had a GUI interface that V2 initially
lacked). In this release, the V2 GUI is now available in all circumstances making it as
functionally complete as the V1 Windows integration. Accordingly, the default for
Windows is now set to V2. Administrators can still select V1.

Browser Support for ClearCase Web Interface

The Web interface no longer supports Netscape 4.7. For information about browser
support for the Web interface, see the Installation Guide for Rational ClearCase.

Changes to Mainframe Connector Remote Builds

The sections that follow describe changes to the mainframe connector remote builds
feature.

Change to the Server Proxy

For messages issued by the Server Proxy to be in Japanese, RCCSESM and RCCSESU
must be stopped and resubmitted after adding the line

export
RCC_CATALOG=rccbld.cat.jpn

to the top of the USS shell scripts, rccSSLMVSServerProxy.sh and rccSSLMVSServer-
Proxy.sh.
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Change to the Client

To see messages issued by the recbuild command in Japanese, you must have set

the environment variable RCC_CATALOG to the value rccbld.cat.jpn before running

rccbuild.

To receive messages from the server in Japanese, you must have set the environment
variable RCC_LANG to the value jpn before running rccbuild.

Changes to the Commands

This section describes changes to the ClearCase command set.

New Commands

This release introduces no new commands.

New Options and Arguments

Table 4 lists new options and arguments to commands.

Table 4 New Options and Arguments
Command | New option/argument Use
chactivity | -view view-tag Transitions an activity in the specified

View.

—cqaction { —cact |
activity-selector ... }

In a single-stream project, checks in the
versions in the change set of an activity
and closes the activity if the relevant
ClearQuest policies have been set.
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Table 4 New Options and Arguments (Continued)

Command | New option/argument Use
checkvob | —ucm Runs checkvob in UCM mode.

—view view-tag Uses the view specified in view-tag.

-log log-dir-pname Specifies an alternative directory for the
log file directory.

—fix [ —force ] Directs checkvob to try to correct any
problems it finds. Without —force, —fix
prompts you before fixing any problem
object.

-verbose Specifies verbose output.

—crm_only Examines only references to records in a
ClearQuest database

-vob_only Examines only references to objects in
components.

—component Further restricts a —vob_only check to the

component-selector component specified by component-selector

object-selector... Specifies the object types that are to be
checked.

—crm_dbname Checks the references held in the

user-database-name ClearQuest database specified by
user-database-name.

—activity cg-display-name Checks the references held by the activity
record specified in cq-display-name.

—project cq-display-name Checks the references held by the project
record specified in cq-display-name.

chproject | -blname_template Defines the baseline name template for a
baseline-naming-template project.
chstream | -cview Specifies the stream connected to the
current view to be modified.
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Table 4 New Options and Arguments (Continued)

Command | New option/argument Use
deliver —reset —to integration-view- | Resets a new integration view so that you
tag can cancel, resume, or complete a deliver
operation after the integration view is lost
during a deliver operation.
—cactivity Specifies that the currently set activity is
to be delivered.
diff —tiny Same as —window, but uses a smaller font
in a 165-character difference window.
-window Displays output in a separate difference
window.
diffbl -nmerge Specifies that no merge is to be performed.
getcache —persistent Displays only those values which have
been set to persist across MVFES restarts.
Isactivity | -me Displays activities owned by the current
user.
—user user Displays activities owned by the specified
user.
1sbl -member_of [ -recurse ] Used by itself, displays the composite
baselines of which each baseline is a direct
member. Used with the -recurse option,
displays all baselines of which each
baseline is a direct or indirect member.
Isstream | —in { project-selector | Displays a list of all streams for the
stream-selector } specified project, or a list of child streams
for the specified stream.
mkbl —view view-tag Specifies the view from which to create
baselines.
mkdir —-master Assigns mastership of the main branch

of the directory element to the VOB
replica in which you execute the mkdir
command.
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Table 4 New Options and Arguments (Continued)

Command | New option/argument Use
mkelem -mkpath For an element that is being created from
a view-private file or directory, this option
creates elements from its view-private
parent directories.
mkproject | -model { SIMPLE | Sets the project model. SIMPLE: A
DEFAULT } single-stream project; DEFAULT: A
multiple-stream project.
mkstream | -readonly Creates a read-only stream.
pro- pname-in-vob Pathname of the VOB tag or of any file
tectvob system object within the VOB.
rmdo -before date-time, —since Deletes DOs at the specified pathname
date-time that were created before or since the
specified date and time.
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Table 4 New Options and Arguments (Continued)

Command

New option/argument

Use

setcache

—persistent

Specifies that all options will be applied
immediately and also set persistently.

—persistent_only

Specifies that all options will be set
persistently but will not take effect until
the MVFS is restarted.

—vobfreemax cnt

Sets the maximum number of free
(unused) attribute cache entries.

—cvpfreemax cnt

Sets the number of entries in the cleartext
cache.

—-vobfreemin cnt

Sets the minimum number of mnodes to
keep on the VOB free list.

—cvpfreemin cnt

Sets the minimum number of mnodes to
keep on the cleartext free list.

—-mnmax cnt Sets the initial number of mnodes cached
by the MVES.

—cto Enables close-to-open consistency
checking.

-ncto Disables close-to-open consistency
checking.

—acache Enables attribute caching.

-nacache Disables attribute caching.

—-dncache Enables directory name caching.

-ndncache Disables directory name caching.

-rlcache Enables readlink caching.

-nrlcache Disables readlink caching.

-rvcache Enables root version caching.

-nrvcache Disables root version caching.

—readdir_blocks cnt

Sets the number of blocks cached for each
directory read by the MVFS.

—scalefactor val

Sets the scaling factor used to initialize
the MVFS with more memory for better
performance.
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Obsolete Command, Options, and Arguments

All ClearCase command options and arguments that were specific to ClearCase
Attache are obsolete.

The clearexport_ffile command was announced as obsolete in version 2002.05.00;
it has been removed from the product.

The dir argument to annotate and the —glossary option for apropos are obsolete.

Changes to Command Output
Significant changes to command output are as follows:

= The event comment for the rmname operation has been changed from Removed
file element toUncataloged file elementto reflect the nature of the operation
more accurately and distinguish it more clearly from the rmelem operation.

= Dates in log files are written in ISO format. Logs reside in /var/adm
/rational/clearcase/log/.

=  Qutput from the schedule command uses ISO dates regardless of any specified
date format preference.

= For attribute types, hyperlink types, and label types, the describe command shows
the instance mastership of the type, whether or not the VOB is replicated.

Changed Commands

Commands that have changed in one or more respects are as follows: annotate,
apropos, chactivity, checkvob, chproject, chstream, deliver, describe, diff, diffbl,
find, getcache, getlog, Isactivity, Isbl, Isstream, Istype, man, mkbl, mkdir, mkelem,
mkproject, mkstream, protectvob, rebase, rmdo, rmname, schedule, setcache. For
details, see the corresponding reference pages.

Changes to the Documentation

This section describes noteworthy changes to the documentation.

HTML Help
Most Help, including reference pages, is HTML.

Command Reference

The following reference pages have been removed from the Command Reference:
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= (ClearCase Attache reference pages have been removed.

= The reference pages for mvfscache and mvfsstat have been removed; see the
Administrator’s Guide for information about these commands.

= The reference page for ClearCase::CtCmd has been removed; for information about
this Perl extension, see the Comprehensive Perl Archive Network (www.cpan.org).

Administrator’s Guide

The Administrator’s Guide contains new information about backing up and restoring
ClearCase and ClearQuest data together.

Tutorial

The script-driven tutorial has been replaced with an HTML tutorial without scripts.

Managing Software Projects

A platform-independent edition of Managing Software Projects replaces the separate
UNIX and Windows editions that were published at earlier releases.

Location of Files

Manuals in Portable Document Format (PDF) are installed in ccase-home-dir/doc/books.
In previous releases, they were installed in ccase-home-dir/doc/hlp.
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What’s New in
MultiSite

This chapter summarizes new and changed features in Version 2003.06.00 of Rational
ClearCase MultiSite. For more information, see the Administrator’s Guide for Rational
ClearCase MultiSite and the Help for MultiSite.

Preserving Permissions in Replicas

You can create new replicas or change existing replicas to preserve permissions.
These replicas synchronize changes to element permissions, but do not synchronize
changes to element ownership. You must raise the VOB family feature level to 4 to
change a replica in the family to a permissions-preserving replica or to create a new
permissions-preserving replica.

Note: To prevent metadata divergence, the protect command fails if you use the

—chmod option, you specify an object in a permissions-preserving replica, and your
client host is running a version of Rational ClearCase associated with feature level 3
or lower. Trigger scripts that run the protect -chmod command fail in this situation.

Replicating a VOB to a Host Running an Earlier Major Version
of ClearCase

You can replicate a VOB to a host running an earlier major version of ClearCase if the
feature level of the VOB or VOB family is the same as the feature level of the ClearCase
release on the target host. For example, if a host is running Version 2003.06.00 with a
VOB at feature level 2, you can replicate that VOB to a host running Version 4.2,
which is associated with feature level 2.

Setting a Timeout Period for Unreachable Hosts During
Shipping Server Operation

The Rational Shipping Server can determine whether a target host was unreachable
during a previous shipping attempt and avoid sending packets to unreachable hosts
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during a specified timeout period. For more information, see the shipping.conf
(UNIX) or MultiSite Control Panel (Windows) reference page.

Changes to Commands

Table 5 lists options and arguments that are new in this release.

Table 5

New Options and Arguments in MultiSite Version 2003.06.00

Command

New option or argument

Description

chreplica

—perms_preserve

Causes the replica to
preserve permissions.

man

contents

Displays the HTML
table of contents for
MultiSite.

mkdir
(cleartool)

—master

Assigns mastership of
the main branch and any
other branches created
during element creation
to the replica in which
you execute the mkdir
command.

mkreplica

—perms_preserve

Creates a replica that
preserves permissions.

mkreplica

—-nprompt

(Used with
—perms_preserve)
Suppresses the prompt.

Changes to Command Syntax

The apropos command no longer supports the —glossary option.

Changes to Command Behavior

In previous releases, if syncreplica —-import tried to import an oplog for an rmreplica
operation, it could fail with the error There are still objects mastered by this
replica. In this release, the replay of the oplog succeeds with a warning. This
behavior was reported as CMBU00063297; RATLC00684693.

It is possible for the oplog for a rmreplica operation to be replayed at a sibling replica
before the last packet from that replica is imported at the sibling replica. In previous
releases, syncreplica —-import could fail with the error Replica has been deleted if
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it tried to import the packet after replaying the rmreplica oplog. In this release, the
import will succeed with a warning. This behavior was reported as CMBU00063321;
RATLC00684707.

When you delete the second-to-last replica in a family, the rmreplica command uses a
series of write transactions to delete oplog entries. This behavior prevents the VOB
database control files from becoming too large.

When the oplog entry for an rmreplica operation is replayed, no mastership checking
is done. This change improves performance during packet import. This behavior
was reported as RATLC00691265.

The Shipping Server sends packets in order of their creation time. They do not
necessarily arrive at a destination site in that order. This behavior was reported as
CMBU00065543; RATLC00686620.

Changes to Command Output

The following sections describe changes to command output.

The regmaster Command

If you request mastership of a branch or branch type associated with a UCM stream,
the reqmaster command fails and prints the following error message:

Requests for mastership of UCM objects are not supported.
The phrase “Mastership is in transit to the new master replica” has been added to the
following reqmaster output messages:

Change of mastership at host “host”
was successful. Change of mastership at sibling replica “replica-name”
was successful.

shipping_server No Longer Prints Message About Port Range

In previous releases, when you used shipping_server on a firewall and the
shipping_server used a port number in the Registered Ports range (1024 through
49151), the shipping.conf parser printed a message recommending that you use

a value in the Dynamic/Private Port Range (49152 through 65535). In this release,
the message is not printed, but we still recommend that you use a value within the
Dynamic/Private Port Range.

The describe Command

For attribute types, hyperlink types, and label types, the describe command shows
the instance mastership of the type, even if the VOB is not replicated.
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For replica objects, the describe —-long command contains two lines that describe
the replica’s preservation mode. In previous releases, the output contained the line
identities: preservedor identities: not preserved. In this release, it also

contains the line permissions: preserved Or permissions: not preserved.
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Restrictions and
Guidelines for Using
ClearCase

This chapter explains restrictions and guidelines affecting the use of Rational
ClearCase Version 2003.06.00 software that are considered noteworthy. These are
not necessarily considered defects because the behavior reported is not expected to
change in a future release of the product.

This chapter also describes significant problems with the documentation and includes
documentation that was inadvertantly omitted from the manuals or Help.

Copyright Information

In some cases, you will not be able to view the Rational copyright information online.
If you want to see this information, you can find it on the ClearCase product CD
under doc/unix/legal_information.html.

Install-Related Restrictions

This section describes restrictions related to the installation of ClearCase.

Install Scripts and Obsolete German Locales

Some German locales are obsolete, such as De, De_DE.646, De_DE.646@EU, and
De_DE.646@TE. If the current locale is set to one of these obsolete versions, the install
scripts may abort with a syntax error. If this occurs, you must select and set a new
locale before rerunning the installation.

ClearCase Mainframe Connectors Remote Build Server Requirements

The updated Remote Build server requirements for ClearCase Mainframe Connectors
can be found in the Rational ClearCase Mainframe Connectors User’s Guide. The Remote
Build server requirements published in the Installation Guide are incorrect.

RWP Default Port Changed on Linux Systems
On Linux installations, the default port number for RWP has been changed from 80 to

81. This avoids a conflict that was found on some systems.
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Red Hat Linux Must be Set to Non-Unicode Locale

By default, Red Hat Linux sets the locale to a Unicode locale, en_us.uTF-8 for US
installations, and may also do so for international installations. ClearCase currently
does not support Unicode locales.

For ClearCase to function correctly, the locale must be explicitly set to a non-Unicode
locale. Possible locales to use are the ¢ locale, en_Us.is0885915, or a locale that was
used successfully in earlier Red Hat Releases.

ClearCase Web

This section describes limitations on and guidelines for using the ClearCase Web
product.

Load Rule Scopes

For the Web interface, snapshot view config spec load rules are specified differently
from the way they are specified for the native interface. The keyword load is not
needed in the Load rule scopes portion of the config spec for the Web client.

Compare/Merge Operations Limited to text_file Elements

The Compare and Merge operations are limited to elements of type text_file. Attempts
to perform these operations on other types will fail.

Using Special Characters on Non-ASCIl Operating Systems

Using special characters on non-ASCII operating systems can cause server output
to be corrupted or the server to crash.

For example, the Shift-JIS double-byte tilde character (FULLWIDTH TILDE), which
is used to indicate “Copy of” in the Japanese Windows environment, can cause this
problem. The problem originates in differences between the Unicode conversion
tables used by ICU (the publicly available Unicode software currently used by the
Web interface) and the base operating system. The ICU Shift-JIS conversion table
maps FULLWIDTH TILDE to WAVE DASH.

Relationship Between Pathnames and Hyperlinks

Pathnames that refer to files in your Web view are normally presented as hyperlinks.
However, the Netscape 7 and Mozilla browsers enforce more stringent security
restrictions than do other browsers. In these browsers, pathnames are not presented
as hyperlinks because they cannot be traversed.
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Handling SSL Warnings

When running the Web interface under SSL, the browser displays warning messages
such as You are leaving a secure site. For example, in the VOB View, this may
happen when you click a file name to view the file. The reason for the warning
message is that a new window is opened to view the local file under the file protocol
rather than under HTTPS. However, if you choose to view the same file by clicking
View on the Properties page, a new window is opened under HTTPS, returning to the
server, and the warning message does not appear.

You can safely ignore these warning messages because all client/server
communications in the Web interface are encrypted. To disable the warning messages:

1 Click Edit > Preferences > Privacy & Security > SSL.

2 In the SSL Warnings section of the SSL page, clear all check boxes.

Web Client Can Be Very Slow When Browsing Large Directories

The Rational ClearCase Web client can be very slow when browsing large directories,
especially when your client PC has a slow CPU or limited RAM. For example, on an
800 MHz PC with sufficient RAM, a 1500 entry directory can take approximately 2
minutes to render.

To work around this situation, use one of the following workarounds:
= Smaller directories
= A client PC with a faster processor speed

= If you are running ClearCase Version 2003.06.00, a Mozilla based browser. Mozilla
based browsers seem to be faster than Microsoft Internet Explorer when browsing
large directories.

Browser Pop-up Windows
When using the ClearCase Web client, display of pop-up windows must be enabled in
your browser.

Unable to shut down rwp process in ClearCase

In Red Hat Linux 9, RWP startup and shutdown do not work correctly because
of a problem with the JRE 1.4.0 that comes with the distribution. To work
around this problem, Red Hat 9.0 users can use the JRE1.4.0 that is installed in
opt/rational/common/java by setting the following environment variable:

LD_ASSUME_KERNEL=2.4.1
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ClearCase-ClearQuest Integration

This section describes restrictions that affect the ClearCase—ClearQuest integration.

Activity Link with ClearQuest Record (UCM-ClearQuest Integration)

When a ClearCase activity in a project enabled for ClearQuest is linked to a
ClearQuest record, the Name of the ClearCase activity is set to match the ClearQuest
record’s ID. This allows you to access the corresponding activity when you are
working on a defect by using the current defect number. For example, you can use
the command, cleartool setactivity ClearQuest-record-ID.

It is recommended that you do not change the name of a ClearCase activity, although
ClearCase does not prevent that. If you change an activity name, you cannot use the
setactivity command as already described.

Note that the Headline field for a ClearCase activity is synchronized with the
corresponding field in a ClearQuest record. That is, if you change this field from
within either ClearCase or ClearQuest, the corresponding field in the ClearQuest
record or ClearCase activity is modified as well.

Naming dbsets (UCM-ClearQuest Integration)
When assigning names to dbsets, follow these rules:
= [f you have only one dbset, you can name it as you want.

= [f you have multiple dbsets, the dbset that is to be associated with the integration
should, if possible, be named the ClearQuest version that you are using; for
example, 2003.06.00.

= [f you have multiple dbsets and none of them can be assigned the name of the
ClearQuest version string, stop the clients and set the SQUID_DBSET environment
variable as follows: setenv SQUID_DBSET dbset-name. Then restart the clients.

Use of Rootless UCM Components

It is no longer possible to make a baseline in a rootless component that is not
modifiable. Making a baseline of a composite component for the purpose of changing
its members is regarded as making a modification in a component. A rootless
component should be modifiable except in the following circumstances:

= The component is to hold only nonmodifiable members.

= No baseline is ever to be made in the component.
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Required Patch for Mixed-Version UCM Environments

In UCM environments that support both 2002.05.00 and 2003.06.00 hosts, 2002.05.00
hosts must apply patch clearcase_p2002.05.00-13 or later. These patches provide
support for the new project policies introduced in 2003.06.00.

Disabled Japanese Text Input in Red Hat Linux GUI

The standard method to toggle between English and Japanese text input mode in Red
Hat Linux GUISs is to type SHIFT SPACE. This method does not work in ClearCase
GUIs. Until the problem is fixed in a later release, the following procedure is
recommended to enable Japanese input on all ClearCase GUISs:

1 Open the .Xdefaults file in your home directory. If the file does not exist, create it.
2 Add the following entry:
*inputMethod: kinput2
3 Save the Xdefaults file.
4 On the command line, type xrdb -q.

5 If the message displayed does not confirm that the kinput2 entry is listed in
Xdefault, type the command, xrdb .Xdefaults to make the change take effect.

Japanese Linux GUIs Cannot Use kterm in a View

GUISs that need to use the kterm multi-byte terminal display in Japanese Linux are not
able to do so when set into a view. For example, in a view context, you cannot open

a file that is under ClearCase control using a screen editor. To use multi-byte kterm
applications, specifiy view-extended path names instead of setting into a view.

Deleting Sockets, Devices and Named Pipes in a View on Linux

When you attempt to delete certain file types (sockets, devices, and named pipes)
while set to a ClearCase view, MVFS does not correctly handle the deletion.

Resolving this problem requires a change to the MVFS and also a patch to the Linux
kernel. For details about the patch, go to the IBM Support & downloads Web page,
http:/ /www-3.ibm.com/software/support, and search for the Technote titled,
LINUX: defects which concern the inability to delete sockets, devices and named
pipes when set to a view.
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Galaxy-based Unix applets not Level 2 or Level 3 compliant

The Galaxy-based Unix applets in ClearCase use third-party libraries that have
not been internationalized. Use the command line for Galaxy applications, such as
cleardescribe, cleargetlog and clearvobadmin.

Timer Patch Support for SUSE Linux 390

ClearCase supports a patch for SuSE Linux SLES? that changes the timing method for
interrupts. The patch enables SLES7 to more efficiently run multiple Linux VMs on
the IBM S/390 platforms. In most cases, ClearCase support requires that you rebuild
the vnode layer after installing the package. The following packages containing the
patch have been released by SuSE:

= kernel-source-20020521.rpm (unpacks to linux-2.4.7.SuSE-53)
Requires a rebuild of the vnode layer.
= kernel-source-20020708.rpm (unpacks to linux-2.4.7.SuSE-66)

Requires a rebuild of the vnode layer, unless the vnode layer is already rebuilt for
the linux-2.4.7.SuSE-53 kernel.

= kernel-source-20030221.rpm (unpacks to linux-2.4.7.SuSE-69)
Requires a relink of the MVFS.

Problems with the Documentation

This section describes significant problems with the documentation and supplies
documentation that is missing from the manuals or the Help.

Browsing the Documentation with Netscape Navigator

If you use Netscape to browse HTML documentation, Netscape 7 is recommended.

Omissions from Building Software
The information that follows was omitted from Building Software.

Standard compatibility mode supports the GNU make export and unexport
statements as well as the .EXPORT_ALL_VARIABLES directive. You can use the
export statement to pass variable or macro values to a sub-make environment. Use
the unexport statement to prevent a variable or macro from being exported to a
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sub-make environment. Using .EXPORT_ALL_VARIABLES causes all variables
in the makefile to be exported.

Standard compatibility mode support Sun pattern rules. You can use these patterns
within your makefile to indicate matching targets. Any target matching the pattern
will have a dependency on the same pattern and will use the same rule as in the
following example:

%.0: %$.c cc -c $< -0 s@

Omissions from the Command Reference

The diffbl reference page does not describe the -nmerge option. The correct syntax
for the first two usage modes of diffbl is as follows:

= Display differences between two baselines or streams nongraphically:
diffbl [ -activities ] [ -versions ] [ -baselines ] [ -first_only]

[ -nrecurse ]| [ -nmerge ] { baseline-selector] | stream-selector1 } { baseline-selector2 |
stream-selector? }

= Display differences between the specified baseline and its predecessor baseline
nongraphically:

diffbl -predecessor [ -activities ] [ -versions ] [ -nrecurse ]
[ -nmerge ] baseline-selector

The -nmerge option is used to compare two baselines on the same stream and reports
only activity and version changes made on that stream.

The protectvob reference page does not describe the pname-in-vob argument. The
correct syntax for this command is as follows:

protectvob [ -force | [ -chown user ] [ -chgrp group | [ -add_group groupl,...]
[ -delete_group group|,...] 1 vob-storage-pname | pname-in-vob } ...

pname-in-vob can be the pathname of the VOB tag (whether or not the VOB is mounted)
or of any file system object within the VOB (if the VOB is mounted). It cannot be the
pathname of the VOB storage directory.

The checkvob —ucm command supports a —verbose option, which directs the
command to generate more detailed output.

Omission from the Administrator’s Guide
The information that follows was omitted from the Administrator’s Guide.

If you install Rational Web Platform (RWP) on a host that was previously using a
different HTTP server to support version 4.2 or version 2002.05.00 of the ClearCase
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Web interface and if that HTTP server must continue to run on that host to support
other applications, you must do the following;:

1 Ensure that RWP and the existing HTTP server do not have any port conflicts.
(This topic is treated in the Administrator’s Guide.)

2 Reconfigure the existing HTTP server to redirect Web interface requests to RWP.
(For information about how to do this, see the documentation for your HTTP
server.)

Omission from Managing Software Projects

The discussion of enabling a schema to work with UCM in Managing Software Projects
for Rational ClearCase omits an important step: mapping states to state types.

When you apply the BaseCMActivity package to a schema, ClearQuest adds the
BaseCMActivity record type. When you apply the UnitedChangeManagement (UCM)
packages to the schema, ClearQuest adds the UCMUTtilityActivity record type. But
when you attempt to check in the schema with these changes, ClearQuest displays

a series of validation errors stating that you need to map BaseCMActivity states to
the AMStates Types package.

You receive this error because, in applying the UCM package to the schema,
ClearQuest also applied the AMState Types package. This behavior is not described in
the Administrator’s Guide for Rational ClearQuest or in Managing Software Projects.

Before you can check in the schema, you must map states to state types from the
AMStates Types to the BaseCMActivity record type, as follows:

1 In ClearQuest Designer, click Package > Setup State Types.

2 In the Setup States Type dialog box, select a State Type for each State listed.
3 Click Finish.

4 Click File > Check in to record your changes in the schema.

For more information about mapping states and state types, see the Administrator’s
Guide for Rational ClearQuest. For more information about enabling the
BaseCMActivity record type, consult the Rational Support Knowledge Database.
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Restrictions and
Guidelines for
MultiSite

This chapter contains release notes for Rational ClearCase MultiSite Version
2003.06.00.

Running protectvob on ldentities-Preserving Replicas

If you run protectvob -chown or protectvob -chgrp on a VOB replica that preserves
identities, you must follow these steps to prevent owner or group metadata
divergence among replicas in the VOB family:

1 Stop synchronization among identities-preserving replicas in the family. Make
sure that all update packets have been imported.

2 Run protectvob -chown or protectvob -chgrp on all identities-preserving replicas
in the family. You must use the same options and arguments in each command.

3 Restart synchronization.

If you do not change the owner or group at all identities-preserving replicas at the
same time, metadata divergence can occur for the owner or group of new elements
created at nonpreserving replicas. When the oplog entry for the new element is
imported at an identities-preserving replica, the element’s owner or group is the
owner or group of the VOB at the time the entry is imported. If a change to the VOB
owner or group has been made at other identities-preserving replicas, the element’s
owner or group will be different at the different replicas.

Problems with Documentation

If no receipt handler is defined for a storage class, but a default receipt handler is
defined, the default receipt handler is invoked for packets in that storage class. The
shipping.conf (UNIX) and MultiSite Control Panel (Windows) reference pages do
not describe this behavior.
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Status of ClearCase 5
Software Change
Requests

Noteworthy problems found in or resolved in Version 2003.06.00 of Rational
ClearCase are listed in the file cc_issues.htm.

You can find this file in two places:

=  On your product CD, in the directory Rational/doc/platform, where platform is
an architecture mnemonic like ux (for UNIX computers) or nt (for Windows
computers).

= In the directory ccase-home-dir/install/ after you install the product.
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Status of MultiSite 6
Software Change
Requests

Noteworthy problems found in or resolved in Version 2003.06.00 of Rational
ClearCase MultiSite are listed in the file ms_issues.htm.

You can find this file:
=  On your ClearCase CD, in the directory Rational/doc/platform.

» In the directory ccase-home-dir/install/ after you install the product.
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